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 Pour une utilisation en toute sécurité

Toute manipulation ou utilisation incorrecte de cette machine peut causer des blessures ou des dégâts 
matériels.
Les consignes à observer pour éviter des blessures ou des dommages sont indiquées de la façon suivante:

Note sur les mentions  AVERTISSEMENT et  ATTENTION

AVERTIS-
SEMENT

Ces informations avertissent l’utilisateur d’un danger de mort ou de blessure grave 

en cas de mauvaise utilisation de l’appareil.

ATTEN-
TION

Ce message appelle à la prudence car il y a risque de blessure ou de dommage 

matériel en cas de mauvaise utilisation de l’appareil.

* Les “dommages matériels” font référence aux dégâts ou à d’autres effets néfastes 

sur le lieu d’utilisation, le mobilier et d’éventuels animaux domestiques.

Symboles
Le symbole  attire l’attention de l’utilisateur sur des instructions importantes ou des 

avertissements. Le sens précis du symbole est déterminé par le dessin à l’intérieur du 

triangle. Le symbole à gauche signifie “danger d’électrocution”.

Le symbole  attire l’attention de l’utilisateur sur des procédures qu’il ne peut jamais 

effectuer (interdites). Le dessin à l’intérieur du cercle précise ce qu’il est interdit de faire. 

Le symbole à gauche signifie qu’il ne faut jamais tenter de démonter l’appareil.

Le symbole  indique les opérations qu’il faut effectuer. L’opération à effectuer est 

indiquée par un dessin à l’intérieur du cercle. Le symbole à gauche indique qu’il faut 

débrancher le cordon d’alimentation de la prise secteur.
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 Pour une utilisation en toute sécurité

 AVERTISSEMENT
Evitez que des enfants ne viennent jouer 
à proximité la machine.
La machine contient des éléments pouvant 
provoquer des blessures. Celles-ci peu-
vent aller jusqu’à provoquer une cécité, un 
étouffement ou d’autres accidents graves.

N’ouvrez jamais le boîtier et n’apportez 
jamais de modifications à la machine.
Cela peut provoquer un incendie, une électro-
cution ou des blessures. Confiez les réparations 
à un technicien qualifié et agréé.

Utilisez exclusivement les accessoires 
(options, consommables, cordon 
d’alimentation etc.) recommandés 
expressément pour cette machine.
D’autres accessoires risquent d’entraîner un 
accident.

N’utilisez jamais cette machine à d’autres 
fins que celles pour lesquelles elle a été 
conçue. Evitez également tout usage 
excessivement intensif.
Cela risque de provoquer un incendie.

 ATTENTION
Placez la machine sur une surface plane 
et stable.
Si vous placez la machine à un endroit inap-
proprié, elle risque de provoquer un accident 
ou de basculer et tomber.

Veuillez suivre les procédures décrites 
dans ce manuel. Ne laissez jamais une per-
sonne non familiarisée avec l’utilisation 
ou la manipulation de cette machine 
s’approcher de cette dernière.
Une utilisation ou une manipulation incorrecte 
peut entraîner des blessures inattendues.

 Une manipulation incorrecte peut entraîner des blessures
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 Pour une utilisation en toute sécurité

 AVERTISSEMENT
Branchez la machine à une prise secteur 
correspondant aux caractéristiques imprimées 
sur l’étiquette de modèle de la machine.
Une tension inadéquate ou un courant insuffisant 
r isque de provoquer un incendie ou une 
électrocution.

N’utilisez jamais d’autre adaptateur secteur 
que celui conçu pour l’appareil.
Cela peut causer un incendie ou une électrocution.

N’utilisez jamais la machine à l’extérieur ou à 
des endroits soumis à une forte humidité ou, a 
fortiori, à la pluie ou à l’eau. Ne touchez jamais 
la machine avec des mains mouillées.
Cela peut provoquer un incendie ou une électro-
cution.

Ne laissez jamais tomber des objets comme 
des trombones, épingles à cheveux, pièces de 
monnaie, allumettes, etc. à l’intérieur de la ma-
chine. Ne renversez pas de liquide à l’intérieur 
de la machine.
Les pièces de monnaie, allumettes, liquides etc. 
pénétrant à l’intérieur de la machine par les fentes 
d’aération risquent de provoquer un incendie ou 
une électrocution. Dans ce cas, débranchez immé-
diatement le cordon d’alimentation et contactez 
votre revendeur Roland DG agréé.

 Risque de court-circuit, d’électrocution ou d’incendie

Etiquette de 
modèle

Ne laissez jamais des enfants s’approcher de la 
machine. N’utilisez jamais d’aérosols combus-
tibles à proximité de la machine. N’utilisez 
jamais la machine à des endroits où il y a 
accumulation de gaz.
Il y a risque d’incendie ou d’explosion.

Soyez prudent avec le cordon d’alimentation, 
la fiche et la prise secteur utilisée. Si un de 
ces éléments est endommagé, débranchez 
immédiatement la machine.
Cela peut provoquer un incendie, une électrocution 
ou des blessures.

Si vous utilisez une rallonge, elle doit 
correspondre aux caractéristiques imprimées 
sur l’étiquette de modèle.
Ne branchez en outre aucun autre appareil à 
consommation élevée sur ce circuit car cela peut 
provoquer un incendie.

Si vous n’avez pas l’intention d’utiliser la 
machine pendant une période prolongée, 
débranchez-la du secteur.
Vous évitez ainsi des dommages ou accidents pro-
voqués par une fuite ou un démarrage intempestif 
de la machine.

Placez toujours la machine de sorte à offrir un 
accès immédiat au cordon d’alimentation.
En cas de problème, vous devez pouvoir débrancher 
immédiatement la prise d’alimentation. Placez la 
machine à côté d’une prise secteur. Laissez toutefois 
assez de place pour un accès immédiat au cordon.

Si vous remarquez une anomalie (fumée ou 
étincelles, odeur de brûlé, bruit inhabituel) du-
rant l’utilisation, débranchez immédiatement 
le cordon d’alimentation. N’utilisez jamais de 
câble ou autre élément endommagé.
Cela peut provoquer un incendie, une électrocution 
ou des blessures. Contactez votre revendeur Roland 
DG agréé.
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 Pour une utilisation en toute sécurité

 Remarques importantes sur le cordon d’alimentation, la fiche et la prise secteur

Ne placez jamais d’objet dessus et ne 
l’endommagez pas.

Evitez de le plier ou de le tordre avec force.

Evitez de tirer dessus avec une force excessive.

Evitez de l’assembler avec d’autres câbles, de 
le lier ou de l’enrouler.

Ne le mouillez jamais.

Evitez de le chauffer.

La poussière risque de provoquer un 
incendie.
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 Pour une utilisation en toute sécurité

Des étiquettes d’avertissement indiquent clairement les parties potentiellement dangereuses de la 
machine. Cette étiquette a la signification suivante. Respectez scrupuleusement son avertissement.
Ne retirez jamais l’étiquette et veillez à ce qu’elle reste lisible.

Prudence: Température élevée
Ne touchez jamais cette zone juste après 
l’impression.

 AVERTISSEMENT
Ne touchez jamais la tête juste après une 
impression.
Vous risqueriez de vous brûler.

 La zone de la tête chauffe

 Etiquette d’avertissement
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Remarques importantes sur le maniement et l’utilisation

Cette machine est un appareil de précision. Pour en obtenir un rendement optimal, veuillez observer 
les consignes importantes ci-dessous. Le non-respect de ces consignes peut entraîner une baisse des 
performances voire un dysfonctionnement ou une panne de la machine.

Cette machine est un appareil de précision.

 Maniez-la avec soin, ne la soumettez jamais à des chocs ou une force excessive.
 Ne gravez jamais un support excédant la plage spécifiée.

Installez la machine à un endroit approprié

 Installez-la dans un lieu où la température et l’humidité ambiantes sont conformes aux plages prescrites.
 Choisissez un lieu tranquille, stable et offrant de bonnes conditions d’utilisation.
 N’utilisez jamais la machine dans un endroit où des substances au silicone sont présentes (huile, graisse, 

spray etc.). Cela risque d’entraver son fonctionnement.

Avant de déplacer la machine

 Quand vous transportez la machine, prenez-la toujours par le dessous avec les deux mains. Si vous portez 
la machine en la saisissant à un autre endroit, vous risquez de l’endommager.

 Quand vous déménagez la machine, n’oubliez pas de placer les cales. Sinon vous risquez de l’endommager.

Impression

 N’essayez jamais d’imprimer sur les bords ou sur d’éventuels orifices du support.
 Le résultat de l’impression varie en fonction des données originales, du support et des réglages. Avant 

d’effectuer l’impression proprement dite, nous vous conseillons de faire un test.
 Toute tentative d’impression sans support risque d’endommager l’aiguille et la tête.
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A propos des modes d’emploi

Documentation livrée avec la machine

La documentation suivante est livrée avec la machine.

 Mode d’emploi du MPX-90M (ce manuel)
Il donne des consignes importantes pour garantir une utilisation en toute sécurité de la machine et explique 
comment l’installer et la manipuler. Il explique également comment installer et utiliser les logiciels inclus.
Lisez-le en premier lieu.

 Aide en ligne pour le pilote METAZA
 Aide en ligne pour Roland METAZAStudio
 Aide en ligne pour Roland SFEdit2
Il s’agit de documentation en format électronique que vous pouvez afficher sur l’écran de votre ordinateur. 
Il suffit d’installer les différents logiciels pour y accéder. Ces documents décrivent en détail les commandes 
utilisées par les logiciels.

 "Accéder à l’aide en ligne du pilote ‘METAZA’" à la p. 22, "Affichage de l’aide en ligne du logiciel" à la p. 23
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1–1 Description de la machine

Caractéristiques

Cette machine permet de graver directement des objets. Elle imprime des images en gravant des points avec 
une aiguille graveuse montée dans la tête.
Vous pouvez imprimer des données matricielles Data Matrix ECC200 et des codes QR sur de petits objets en 
acier utilisés à des fins médicales. Vous pouvez imprimer différents codes successivement, sans devoir arrêter 
l’impression pour entrer de nouvelles données pour chaque instrument à graver (impression variable).

Nom des composants

Cette machine

Tête

Couvercle

Molette

Prise du cordon d’alimentation

Interrupteur/bouton d’avance

Bouton du pointeur laser

Bloc de tête

Prise USB

Ouvrez le couvercle en tenant sa partie 
centrale. 
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1–1 Description de la machine

Tête (MPH-90)

Aiguille

“L’impression” désigne ici une gravure sur métal avec 
une aiguille graveuse. L’aiguille dispose d’une pointe 
en diamant. La tête est une pièce soumise à usure et 
doit être remplacée régulièrement.
 "Remplacement de la tête" à la p. 52

Maintien de la pièce

Etau

Il permet de maintenir l’instrument à graver.
 "Etape 1: Installer l’instrument à graver" à la p. 35

Table, feuille adhésive

Ce dispositif permet de maintenir un instrument à 
graver qui ne peut pas être monté sur l’étau. La feuille 
adhésive est placée sur la table puis l’instrument est 
posé sur la feuille. Cela vous permet de maintenir 
des objets sans utiliser de ruban adhésif disponible 
dans le commerce.
 "Etape 1: Installer l’instrument à graver" à la p. 35
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1–1 Description de la machine

Chapitre 1 Notions de base

Vérifier le contenu de l’emballage

Les éléments suivants sont fournis et emballés avec la machine. Assurez-vous qu’il n’en manque aucun.

Adaptateur secteur (1) Câble d’alimentation (1) Câble USB (1)

Etau (1) Table (1) Feuille adhésive pour étau (1)
(installée sur l’étau en usine)

Feuille adhésive pour table (1) Capuchons de tête (arrondis) (10)
(un capuchon est installé en usine)

Capuchons de tête (plats) (10)

Tête (MPH-90) (1)
(installée sur la machine en usine)

Supports de test (4)
(Plaques à couche de laiton)

Clé hexagonale (1)

CD-ROM avec logiciels Roland 
(1)

Mode d’emploi (1)
(ce document)



1–2 Installation

Environnement

Choisissez un lieu tranquille, stable et offrant de bonnes conditions d’utilisation. Un endroit inadéquat peut 
causer un accident, un incendie, des dysfonctionnements ou des pannes.

ATTENTION	 Placez la machine sur une surface plane et stable.
Si vous placez la machine à un endroit inapproprié, elle risque de provoquer un 
accident ou de basculer et tomber.

 Ne l’installez jamais dans des endroits soumis à d’importantes fluctuations de température ou d’humidité.
 Ne l’installez jamais dans des endroits soumis à des vibrations.
 Ne l’installez jamais dans des endroits où le sol est incliné, accidenté ou instable.
 Ne l’installez jamais dans des endroits poussiéreux, sales ou à l’extérieur.
 Ne l’installez jamais dans des endroits exposés aux rayons directs du soleil ou à proximité d’appareils de 

climatisation ou de chauffage.
 Ne l’installez jamais dans des endroits exposés à des interférences électriques ou magnétiques considérables 

ou à d’autres formes d’énergie électromagnétiques.
 N’utilisez jamais la machine dans un endroit où des substances au silicone sont présentes (huile, graisse, 

spray etc.).

Retirer et ranger les cales

La machine est dotée de cales pour la protéger contre les vibrations durant le transport. Retirez-les après avoir 
placé la machine à l’endroit voulu.
 Enlevez toutes les cales. La moindre cale oubliée peut entraîner un mauvais fonctionnement ou une panne 

à la mise en service.
 Les cales et l’emballage sont indispensables pour déplacer la machine. Conservez-les donc soigneusement 

pour éviter de les égarer.

La machine est calée en trois points (avec 5 vis et 2 cales). Retirez toutes les vis et cales avec la clé hexagonale 
fournie.
Conservez les vis et les cales en les fixant dans le bas du panneau arrière de la machine. 

Rangement

Cale

Clé 
hexagonale

Démontage

Cale

15Chapitre 1 Notions de base
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1–2 Installation

Chapitre 1 Notions de base

Connexion du cordon d’alimentation

AVERTISSEMENT	 Ne branchez jamais l’appareil à une prise de courant ne répondant pas aux 
caractéristiques électriques figurant sur l’adaptateur secteur.
Cela peut causer un incendie ou une électrocution.

 AVERTISSEMENT	 N’utilisez jamais d’autre adaptateur secteur et cordon d’alimentation que ceux 
fournis avec la machine.
Cela peut provoquer un incendie ou une électrocution.

AVERTISSEMENT	 Soyez prudent avec le cordon d’alimentation, la fiche et la prise secteur utilisée. 
N’utilisez jamais un élément endommagé.
Cela peut provoquer un incendie, une électrocution ou des blessures.

AVERTISSEMENT	 Si vous utilisez une rallonge, elle doit correspondre aux caractéristiques (ten-
sion, fréquence et courant) imprimées sur l’étiquette de modèle.
Ne branchez en outre aucun autre appareil à consommation élevée sur ce circuit 
car cela peut provoquer un incendie.

NE branchez PAS encore le câble USB.

Câble d’alimentation

Adaptateur secteur

Prise sec-
teur

Machine

Important
N’effectuez PAS encore la connexion avec l’ordinateur.
Le non-respect de cette procédure peut empêcher l’installation du pilote. Installez d’abord le pilote 
METAZA avant d’effectuer la connexion avec l’ordinateur.

 "Installation du pilote et des logiciels" à la p. 18



1–3 Installation des logiciels

Système requis

Système d’exploitation * Windows XP/Vista/7 (édition 32/64 bits)

Processeur Intel® Core 2 Duo ou mieux (Core i5 ou mieux recommandé)

Mémoire 1Go ou mieux (2Go ou mieux recommandé)

Lecteur optique Lecteur CD-ROM

Carte vidéo et écran Couleurs 16 bits au moins (“High Color”) et une résolution de 1024 x 
768 ou plus de préférence

Espace disponible sur 
le disque dur (pour 
l’installation)

25Mo

* Comme ce logiciel est une application 32 bits, il tourne sous WOW64 (“Windows-On-Windows 64”) pour la 
version Windows à 64 bits.

Pour obtenir les informations les plus récentes, veuillez consulter le site web de Roland DG (http://www.
rolanddg.com).

Logiciels que vous pouvez installer et configurer

METAZAStudio 

Ce programme permet de préparer les données d’impression.
Il permet d’importer et d’imprimer des symboles 2D (codes QR etc.). 
Il permet aussi d’éditer et de créer des codes 2D, d’entrer directement 
du texte et d’effectuer une impression variable (vous pouvez imprimer 
différents codes successivement sans devoir arrêter l’impression afin 
d’entrer de nouvelles données pour chaque instrument à graver). 

SFEdit2

Ce programme permet de créer et de modifier des polices à traits. Les 
polices à traits sont des dessins linéaires créés par extraction automatique 
des traits centraux d’une police TrueType. “METAZAStudio” permet 
d’utiliser les polices à traits créées comme polices de caractères.

MPX-90M Head Manager Cet utilitaire permet de régler la tête. Faites-le tourner lorsque vous 
remplacez la tête ou réglez l’aiguille.

METAZA Driver (pilote) Pilote Windows requis pour transmettre des données d’un ordinateur 
à la machine.

17Chapitre 1 Notions de base



Installation du pilote et des logiciels

Procédure

 Avant de commencer l’installation et la configuration, assurez-vous que le câble USB n’est 
PAS branché.

 Ouvrez une session dans Windows en tant qu’administrateur.

Insérez le CD-ROM de logiciels Roland dans l’ordinateur.
Windows Vista/7: Quand la fenêtre de lecture automatique apparaît, cliquez sur [Run menu.exe].
Le menu d’installation apparaît automatiquement.

 Cliquez sur [Install].
Installez simultanément le pilote METAZA et les logiciels.
 "Logiciels que vous pouvez installer et configurer" à la p. 17

Vous pouvez installer le pilote et les logiciels séparément.
 "Installer le pilote METAZA séparément" à la p. 72, "Installer un 

logiciel séparément" à la p. 76.

Si vous utilisez Windows Vista ou Windows 7: Quand 
la fenêtre “Contrôle de compte d’utilisateur” apparaît, 
cliquez sur [Autoriser] ou [Oui].

 Sélectionnez “Install”, le nom du modèle (“Roland 
MPX-90M”), le port “USB” puis cliquez sur [Start].
L’installation du pilote METAZA commence. Effectuez 
l’installation en suivant les consignes affichées à l’écran.

Important
Pour brancher la machine à un ordinateur, suivez scrupuleusement les instructions suivantes.
Le non-respect de cette procédure peut empêcher l’installation du pilote.
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Windows Vista/7:

Quand la fenêtre illustrée apparaît, cliquez sur 
[Installer ce pilote quand même].

Windows XP:

Quand l’affichage suivant apparaît à l’écran, cliquez 
sur [Continuer].

 Effectuez l’installation en suivant les consignes affichées à l’écran.
Les informations relatives à l’installation de chaque logiciel sont affichées automatiquement.

 Après l’installation, cliquez sur  dans la fenêtre d’installation.

 Ejectez le CD-ROM de logiciels Roland de l’ordinateur.

 Mettez la machine sous tension.
 "Etape 1: Mise sous tension" à la p. 27

 Branchez la machine à l’ordinateur avec un câble USB.
 Ne branchez jamais plusieurs machines à un même ordinateur.
 Utilisez le câble USB fourni.
 N’utilisez pas de hub USB.
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Windows Vista/7:
Le pilote est installé automatiquement.

Windows XP:
 Sélectionnez “Non” et cliquez sur [Suivant].

 Choisissez [Installer le logiciel automatiquement] 
puis cliquez sur [Suivant].

 Cliquez sur [Terminer].

Si cet affichage apparaît durant l’installation

Cliquez sur [Continuer].

Ejectez le CD-ROM contenant les 
logiciels Roland (“Software Package”) 
de l’ordinateur, cliquez sur [Précédent] 
et recommencez à partir de l’affichage 
précédent.
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Ouvrir la fenêtre ‘Printing Preferences’ du pilote METAZA

Procédure

 Dans le menu “Démarrer” ( ), cliquez 
sur [Périphériques et imprimantes] (ou 
[Imprimantes et télécopieurs]).

 Faites un clic droit sur [Roland MPX-90M] puis 
cliquez sur “Printing Preferences”.
La fenêtre “Printing Preferences” du pilote METAZA 
s’ouvre.

Fenêtre de dialogue “Printing Preferences”
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Accéder à l’aide en ligne du pilote ‘METAZA’

Ouvrez la fenêtre “Printing Preferences” du pilote METAZA puis cliquez sur [Help].
 "Ouvrir la fenêtre ‘Printing Preferences’ du pilote METAZA" à la p. 21

Lancer le logiciel

Dans le menu [Démarrer] ( ), cliquez sur [Tous les programmes] > [logiciel voulu] > [logiciel voulu].

22

1–3 Installation des logiciels

Chapitre 1 Notions de base



Affichage de l’aide en ligne du logiciel

Lancez le logiciel puis cliquez sur [Help] > [Contents] dans le menu.
 "Lancer le logiciel" à la p. 22
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2–1 Préparations pour l’impression

Préparations: tâches avant l’impression

Préparer la machine MPX‑90M
Mettez la machine sous tension et sélectionnez-la comme “imprimante” pour l’ordinateur.

 "Etape 1: Mise sous tension" à la p. 27, "Etape 2: Sélection de la machine dans ‘METAZAStudio’" à la p. 28

Préparer l’instrument à graver
Vérifiez si l’objet à graver répond à tous les critères exigés par la machine (dimensions, dureté etc.).

 "Etape 3: Préparer l’instrument à graver" à la p. 28

Préparer les données d’impression
Les données d’impression sont généralement basées sur des fichiers CSV.

 "Etape 4: Préparation des données d’impression" à la p. 30

Lancer l’impression
Placez l’objet à graver dans la machine et lancez l’impression avec “METAZAStudio”.

 "Etape 1: Installer l’instrument à graver" à la p. 35, "Etape 2: Impression" à la p. 43
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Etape 1: Mise sous tension

Procédure



Serrer

Butée

Ouvrez le couvercle et desserrez la butée 
de la tête.



Interrupteur/bouton d’avance

Appuyez sur l’interrupteur/bouton d’avance.
Le témoin de l’interrupteur/du bouton d’avance 
s’allume et la tête se déplace vers l’arrière. Cette 
opération s’appelle initialisation.

Quand le témoin de l’interrupteur clignote
Il indique une erreur d’initialisation. Desserrez la butée de la tête et appuyez sur l’interrupteur/bouton 
d’avance. L’erreur est supprimée et le témoin de l’interrupteur reste allumé. 
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Etape 2: Sélection de la machine dans ‘METAZAStudio’

Procédure

 Lancez “METAZAStudio”.
 "Lancer le logiciel" à la p. 22

 Cliquez sur [File]> [Set up the printer].
La boîte de dialogue “Print Setup” s’affiche.

  Sélectionnez “MPX‑90M”.
 Cliquez sur [OK].

Etape 3: Préparer l’instrument à graver

Les objets pouvant être gravés doivent répondre aux spécifications suivantes. Travaillez exclusivement avec 
des objets répondant à tous ces critères.

Epaisseur

Avec l’étau: 0,3~20mm
Avec la table: 0,3~40mm

Dimensions

L’objet doit être assez grand pour pouvoir être maintenu convenablement.
Cette machine permet d’utiliser l’étau ou une feuille adhésive pour fixer l’objet à graver. Les objets peuvent 
dépasser de l’étau ou de la feuille adhésive: l’important est qu’ils puissent être correctement maintenus.
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Dureté de la surface à graver

La dureté Vickers (HV) de la surface à graver ne peut pas dépasser 200.
Vous ne pouvez pas utiliser un support qui risque de se fendre ou de se casser pendant la gravure (verre, 
pierre, pierres précieuses, vaisselle et porcelaine), même si sa dureté est conforme aux spécifications énoncées.
L’utilisation de ces supports peut endommager la machine.
La dureté Vickers (HV) est une unité servant à mesurer la dureté de matériaux industriels. Pour connaître la 
dureté de l’instrument à graver, renseignez-vous auprès de son vendeur ou de son fabricant.

Forme de la surface

N’utilisez jamais des objets répondant à la description ci-dessous.
 N’utilisez pas un support irrégulier dont certains endroits touchent la tête lors de l’installation ou 

de l’impression.

Conditions pour graver des surfaces courbes

Le tableau et l’illustration ci-dessous montrent la zone de gravure assurée et la zone pouvant être atteinte 
par les aguilles en fonction du diamètre du cylindre. Notez, cependant, que les conditions suivantes doivent 
être respectées.
 Le capuchon de tête doit être utilisé.
 Le support doit être circulaire.

Diamètre d’un support 
cylindrique

Surface imprimable 
recommandée (A)

Zone atteinte par l’aiguille de 
gravure (B)

10mm 2,0mm 2,8mm
20mm 2,8mm 4,0mm
30mm 3,4mm 4,8mm

Remarque: Pour la gravure sur des surfaces courbes, quelle que soit la forme ou la composition du support, 
la qualité d’image de données photographiques ne peut pas être garantie. 
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Etape 4: Préparation des données d’impression

La section ci-dessous explique comment préparer des données pour impression variable. Pour l’impression 
variable, il faut un fichier CSV. Vous pouvez créer un fichier CSV à partir de fichiers de bases de données et de 
tableurs. Pour savoir comment créer un fichier CSV, veuillez vous adresser à un gestionnaire de bases de données.
Vous pouvez imprimer du texte ou des symboles 2D. Les données “Data Matrix” ou les “codes QR” sont des 
symboles 2D.

* “METAZAStudio” permet de créer directement des symboles 2D, ce qui évite de passer par un fichier CSV.
 "Créer directement des symboles 2D" à la p. 56

1. Création d’un champ variable.

 Lancez “METAZAStudio”.
 "Lancer le logiciel" à la p. 22

La boîte de dialogue “Select Material” s’affiche.

Quand “METAZAStudio” est activé, cliquez 
sur . 
La boîte de dialogue “Select Material” s’affiche.

 Dans la fenêtre de dialogue “Select Material”, 
sélectionnez la matière de l’instrument à 
graver.
Si vous voulez préciser la matière de l’instrument, 
désélectionnez la case “Use printer driver settings”. 
Si vous utilisez une matière qui ne figure pas dans la 
liste, vous pouvez créer une nouvelle entrée.
  "Sauvegarder un type de matière et régler la force de 

frappe" à la p. 59

Si vous souhaitez utiliser les réglages du pilote tels 
quels, cochez la case “Use printer driver settings”.

Qu’est-ce que l’impression variable?
L’impression variable permet de remplacer une partie des données imprimées pour chaque objet et 
d’en individualiser le marquage. Avec l’impression variable, il n’est pas nécessaire de créer de nouvelles 
données d’impression pour chaque instrument médical en acier. L’impression de données différentes 
se poursuit sans interruption. 

Qu’est-ce que le ‘champ variable’?
Le champ variable est un cadre dans lequel vous pouvez placer un symbole 2D ou du texte. En mode 
d’impression variable, les données placées dans le champ variable sont remplacées lors de chaque 
impression. 
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 Cliquez sur [OK].

 Pour les symboles 2D
Cliquez sur  puis sur .

Pour du texte

Cliquez sur  puis sur .

 Maintenez le bouton gauche de la souris enfoncé et faites glisser la souris en diagonale vers 
le bas sur la zone de travail* dans “METAZAStudio”.
Vous créez ainsi un champ variable dans lequel vous pouvez placer un symbole 2D ou du texte.
* Zone de travail= zone noire à l’écran
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 Cliquez sur [Object] > [Move to Center].
Le centre du champ variable est placé au centre de la 
zone de travail.

 Cliquez sur .
La boîte de dialogue “Properties” s’affiche.

Tant que le champ variable n’est pas sélectionné, vous ne pouvez pas cliquer sur . Si  n’est pas 
accessible, cliquez d’abord sur  puis sur le champ variable.

Important
Cette étape est importante car elle détermine la position d’impression réelle.
La machine utilise la position centrale comme point de référence pour l’impression. Cela signifie que 
le centre de la zone de travail de “METAZAStudio” sert de point de référence pour la machine. Il n’est 
possible d’obtenir un résultat prédictible que si le champ variable se trouve au centre de la zone de 
travail et correspond au point de référence de l’impression.
Vous pouvez obtenir des résultats corrects quand le champ variable n’est pas exactement au centre 
mais la coïncidence entre le centre du champ variable et le point de référence de l’impression facilite 
le positionnement du texte ou de l’image. 
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 Entrez les caractéristiques (dimensions etc.) du champ variable.
Le type et le nombre de paramètres diffèrent selon que vous imprimiez un symbole 2D ou du texte. Pour 
en savoir plus sur les différents paramètres, voyez l’aide en ligne de “METAZAStudio” (“Commands” – menu 
“Object” – “Properties” – fenêtre de dialogue “[Properties”).

 "Affichage de l’aide en ligne du logiciel" à la p. 23

Fenêtre de dialogue “Properties” pour symboles 2D

Fenêtre de dialogue “Properties” pour texte

Quand les réglages sont terminés, cliquez sur [OK].

2. Placez un symbole 2D ou du texte dans le champ variable.

 Cliquez sur [Load CSV File].
La boîte de dialogue “Open…” s’affiche. Si la fenêtre “Variable Printing” n’apparaît pas, cliquez sur .

Fenêtre ‘Variable 
Printing’
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 Choisissez un fichier CSV et cliquez sur [Open].
Le fichier CSV est importé dans “METAZAStudio”.

 Faites glisser le titre de la colonne du fichier CSV importé dans le champ variable.
Le champ variable affiche alors un symbole 2D ou un texte.

Vous pouvez afficher les différents symboles successivement en cliquant sur . Si vous voulez 
changer les dimensions ou l’emplacement du champ variable, ou les dimensions de la cellule du symbole 
2D, ouvrez la fenêtre de dialogue “Properties” avec  et modifiez les réglages.

Les données d’impression sont prêtes. Passez à la section  "2–2 Lancer l’impression" à la p. 35. 
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Etape 1: Installer l’instrument à graver

Selon la taille et de la forme de l’instrument à graver, choisissez l’étau ou la table pour le maintenir. Choisissez 
l’étau ou la table en fonction des critères suivants:

 Etau _ Les dimensions et la forme de l’instrument permettent de le fixer avec l’étau.
 Table _ L’instrument a un fond plat. De plus, ses dimensions et sa taille empêchent de le maintenir 

avec l’étau.

1. Attachez le capuchon de la tête.

 Effectuez toutes les préparations pour l’impression.
 "2–1 Préparations pour l’impression" à la p. 26

 Si le bloc de tête est abaissé, appuyez sur l’interrupteur/bouton d’avance.
La tête se déplace dans le coin arrière gauche.


Anneau

Butée

Desserrer

Desserrez la butée de la tête.
La butée et l’anneau se touchent.



Molette

Le centre de la molette doit 
se trouver juste au-dessus du 
triangle. 

Serrer

Bloquez la butée de la tête.
Alignez le centre de la molette avec l’extrémité 
supérieure du triangle et bloquez la butée.
Si vous imprimez avec la butée desserrée, les 
vibrations risquent de faire tomber la molette.
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

Capuchon de tête

Maintenez la tête.

Tête

Fixez un capuchon à l’extrémité de la tête.
Fixez-le en maintenant la tête, comme le montre 
l’illustration. Le capuchon est correctement fixé quand 
son onglet s’insère avec un déclic.

Forme du capuchon de tête
Il existe des capuchons de tête de deux formes différentes. Le choix se fait en fonction de la surface 
d’impression.

Capuchon plat
Ce type de capuchon est conçu pour une surface plane. Ce type de capuchon ne 
détecte pas les surfaces courbes ni les inclinaisons: il ne faut donc pas l’utiliser avec 
ces surfaces. Il offre une bonne résistance à l’abrasion et a une longue durée de vie.

Capuchon arrondi
Ce type de capuchon détecte facilement les surfaces courbes et les inclinaisons: 
il est donc recommandé pour ces surfaces. Il s’use cependant plus rapidement 
que le capuchon plat.

Précautions lors de l’utilisation d’un capuchon de tête
Nettoyez la surface d’impression de toute poussière ou saleté.
Si la surface d’impression n’est pas parfaitement propre, la qualité de l’impression risque de s’en 
ressentir. Nettoyez la surface d’impression de toute poussière ou saleté avant l’impression.

Même pour l’impression test, il est conseillé d’utiliser un support propre et non rayé.
Certaines matières peuvent rayer et tacher le capuchon de tête durant l’impression, ce qui peut 
nuire à la qualité de l’impression. Des rayures et des taches sur l’instrument à graver peuvent aussi 
endommager le capuchon et entraver la qualité de l’impression. C’est pourquoi les supports de test 
doivent également être propres et non rayés.
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2. Placez l’instrument à graver sur l´étau.

Si vous utilisez la table, voyez p. 40.

 Poussez l’arrière de l’étau (là où se trouve la poignée) contre l’unité principale.
Alignez les côtés de l’étau avec les guides d’alignement et abaissez l’avant de l’étau.
Quand les onglets situés sous l’étau s’insèrent dans les orifices de la machine, le montage de l’étau est 
terminé.

Poignée

Guide 
d’alignement

 Tournez les molettes de réglage fin pour aligner les couches de la table.

Table

Molette de réglage 
fin
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 Relevez la pince de l’étau.
Pour relever ou abaisser la pince, veillez à utiliser sa poignée.

Pince

Poignée

 Placez l’instrument à graver sur la table de l’étau et abaissez la pince.
Pour choisir la position de l’instrument, suivez les consignes ci-dessous.
 La zone à graver doit se trouver sur la feuille en résine de la table.
 La zone à graver doit être à 10mm au moins des bords de la pince.
 L’instrument doit être bloqué de sorte à être difficile à déplacer à la main.
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

Bouton du pointeur laser

Appuyez sur le bouton du pointeur laser.
Le pointeur laser s’allume.
Si la machine reste inutilisée 5 minutes, le pointeur 
laser s’éteint automatiquement.

  Soulevez le levier de blocage.
 Déplacez la table pour que le pointeur laser soit au centre de la zone à graver.

Pour affiner la position de la table, utilisez les molettes de réglage fin. La position de la table est réglable 
sur une plage de ±2mm.

 Abaissez le levier de blocage.

Molette de réglage fin

Zone de gravure

Levier de blocage

Pointeur laser

Si vous souhaitez utiliser le capuchon de la tête pour l’impression, les préparatifs de la gravure sont 
terminés. Voyez “Etape 2: Impression”.
Si vous n’utilisez pas de capuchon de tête, passez à l’étape 3. à la p. 42.

La position indiquée par le pointeur laser est le point central de la zone de travail dans “METAZAStudio”. 
C’est la raison pour laquelle le pointeur laser doit se trouver au centre de la zone à graver. 
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2. Placez l’instrument à graver sur la table.

Si vous utilisez l’étau, voyez p. 37.

 Installez la table.
Placez la table en l’alignant avec le cadre de la machine. Quand les onglets situés sous la table s’insèrent 
dans les orifices de la machine, le montage de la table est terminé.

Table



Feuille adhésive pour table

Table

Fixez la feuille adhésive pour table à la table.
Placez-la droite à l’intérieur du cadre de la table, en 
suivant les indications d’échelle. Veillez à ne pas laisser 
de bulles d’air se former entre la feuille adhésive et 
la table.



Bouton du pointeur laser

Appuyez sur le bouton du pointeur laser.
Le pointeur laser s’allume.
Si la machine reste inutilisée 5 minutes, le pointeur 
laser s’éteint automatiquement.

 Si vous remarquez que la feuille perd de son 

pouvoir d’adhérence, nettoyez-la à l’eau.

 "Nettoyer la feuille adhésive" à la p. 48

 Ne frottez jamais la surface avec une force 
excessive. Vous endommageriez la surface 
ce qui réduirait la force d’adhérence.
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 Placez l’instrument à graver sur la feuille adhésive.
Déplacez la table pour que le pointeur laser soit au centre de la zone à graver.
Placez l’instrument à graver sur la feuille adhésive et appuyez doucement dessus.
Si l’instrument dépasse de la table et s’incline, placez un support pour le maintenir horizontal.

Zone de gravure

Pointeur laser

Si vous souhaitez utiliser le capuchon de la tête pour l’impression, les préparatifs de la gravure sont 
terminés. Voyez "Etape 2: Impression" à la p. 43.
Si vous n’utilisez pas de capuchon de tête, passez à l’étape 3.

La position indiquée par le pointeur laser est le point central de la zone de travail dans “METAZAStudio”. 
C’est la raison pour laquelle le pointeur laser doit se trouver au centre de la zone à graver. 

IMPORTANT
L’utilisation d’un capuchon de tête est généralement recommandé.
Quand vous utilisez un capuchon de tête, la machine détecte automatiquement la hauteur de la pièce 
et règle la position de la tête en conséquence. Vous pouvez graver une surface courbe. (Il y a toutefois 
une limite à la hauteur pouvant être détectée.) Le recours au capuchon de tête est généralement 
recommandé pour l’impression.
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3. Réglez la hauteur de la tête (si aucun capuchon n’est utilisé)

 Appuyez sur l’interrupteur/bouton d’avance.
La tête se déplace jusqu’à la position où l’extrémité du capuchon touche la surface de l’instrument à graver.

Interrupteur/bouton d’avance


Desserrer

Desserrez la butée de la tête.



Le centre de la molette doit 
se trouver juste au-dessus du 
triangle.

 Abaissez complètement la butée.
 Bloquez la butée.

Alignez le centre de la molette avec l’extrémité 
supérieure du triangle.
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

Interrupteur/bouton d’avance

Appuyez sur l’interrupteur/bouton d’avance.
La tête se déplace dans le coin arrière gauche.


Maintenez la tête.

Capuchon de tête
Tenez le bord du capuchon pour 
faciliter son extraction. 

Détachez le capuchon.

Etape 2: Impression

Quand les préparations pour l’impression sont terminées et l’instrument à graver est installé, l’impression 
peut démarrer.

 "2–1 Préparations pour l’impression" à la p. 26, "Etape 1: Installer l’instrument à graver" à la p. 35

Procédure

 Cliquez sur .
La boîte de dialogue “Print” s’affiche.
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 Réglez les paramètres ci-dessous.
Printer 
Name

Roland MPX-90M	

Print 
Range

Si vous ne voulez imprimer que certaines entrées (variables) de la banque de données, 
précisez la plage de “pages” voulue. Exemple: si vous ne voulez imprimer que les 
entrées 2~5, cliquez sur [Pages] puis entrez les réglages “From 2” et “To 5”.

Copies Si vous voulez graver le même instrument à plusieurs endroits, précisez le nombre 
de copies. Si, par exemple, vous souhaitez graver les faces avant et arrière d’un 
instrument, choisissez “2” copies. 

Material Entrez la matière de l’instrument à graver et précisez la qualité d’impression (priorité 
à la qualité ou à la vitesse). Le choix effectué lorsque vous créez de nouvelles données 
d’impression est reflété dans le réglage de matière. Vous pouvez cependant changer 
ce réglage avant l’impression. Les réglages effectués ici ont priorité sur les réglages 
du pilote METAZA. 

 Cliquez sur [OK].
L’impression démarre.

Si vous imprimez plusieurs objets (“pages”), le 
message illustré apparaît après le démarrage de 
l’impression.
Attendez la fin de l’impression avant de passer à 
l’étape suivante.

 Placez l’objet suivant ou tournez l’objet pour effectuer l’impression suivante.
 "Etape 1: Installer l’instrument à graver" à la p. 35

Utilisez le bouton du pointeur laser pour régler la nouvelle position. 
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 Cliquez sur [OK].
L’impression suivante démarre.

* Certains scanners ne sont pas en mesure de lire les symboles 2D gravés par la machines car ils ne reconnaissent 
pas les symboles 2D. Pour savoir quels scanners utiliser, veuillez nous contacter ou consulter votre revendeur 
agréé Roland DG.

Si vous souhaitez n’imprimer que l’entrée affichée:

Cliquez sur .
La boîte de dialogue “Print” s’affiche.
Le numéro (“numéro de page”) de l’entrée affichée par “METAZAStudio” apparaît à côté de “From”. Réglez 
les paramètres “Material” et “Copies” comme vous le voulez et cliquez sur [OK] pour lancer l’impression.

Etape 3: Terminer l’impression (éteindre la machine)

Interrupteur/bouton d’avance

Maintenez l’interrupteur/bouton d’avance en-
foncé pendant au moins une seconde.
Le témoin s’éteint et l’alimentation est coupée.
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2–3 Terminer et arrêter l’impression

Arrêter l’impression

Interrupteur/bouton d’avance

Maintenez l’interrupteur/bouton d’avance enfoncé 
pendant au moins une seconde.
Le témoin clignote lentement durant la suppression des 
données d’impression transmises. Le témoin s’éteint et 
l’alimentation est coupée.

Supprimer des données de la file d’impression

Procédure

 Windows 7
Dans le menu “Démarrer” ( ), cliquez sur [Panneau de configuration] > [Matériel et son] > 
[Périphériques et imprimantes].

Windows Vista
Dans le menu “Démarrer” ( ), cliquez sur [Panneau de configuration] > [Matériel et son] > 
[Imprimantes].

Windows XP
Dans le menu “Démarrer” ( ), cliquez sur [Panneau de configuration] > [Imprimantes et 
autres périphériques] > [Imprimantes et télécopieurs].

 Double-cliquez sur l’icône [Roland MPX‑90M].

 Dans le menu “Imprimantes”, cliquez sur [Annu-
ler tous les documents] (ou [Purger les travaux 
d’impression]).

 Si une demande de confirmation apparaît, cliquez 
sur [Oui].
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3–1 Entretien et réglages

Remarques concernant l’entretien quotidien

 AVERTISSEMENT	 N’utilisez jamais d’essence, d’alcool, de dissolvant ou d’autre produit inflam-
mable.
Cela risque de provoquer un incendie.

 ATTENTION	 Ne touchez jamais la tête juste après une gravure.
Vous risqueriez de vous brûler.

 Cette machine est un appareil de précision particulièrement sensible à la poussière et à la saleté. N’oubliez 
pas de la nettoyer quotidiennement.

 N’utilisez jamais de solvants comme du dissolvant, du benzène ou de l’alcool.
 Cette machine ne doit en aucun cas être graissée ou huilée.
 N’appliquez jamais de substances au silicone (huile, graisse, spray etc.) sur la machine. Cela risque d’entraver 

son fonctionnement.

Nettoyer la machine, l’étau et la table

Utilisez un chiffon imbibé d’eau et bien essoré pour nettoyer doucement ces éléments.
Le couvercle se raye facilement: utilisez donc un chiffon doux.

Nettoyer la feuille adhésive

Une accumulation de limaille ou de poussière peut réduire l’adhérence de la feuille adhésive et provoquer un 
glissement du support pendant la gravure. Si vous remarquez que la feuille perd de son pouvoir d’adhérence, 
nettoyez-la à l’eau.

Nettoyage

Immergez la feuille adhésive dans l’eau et lavez-la en frottant doucement sa surface. Si la feuille est très sale, 
vous pouvez la nettoyer à l’aide d’un peu de détergent neutre dilué. Rincez-la complètement à l’eau pour 
enlever tout le détergent.

Suivez impérativement les instructions ci-dessous.
A défaut, vous risquez d’endommager la surface de la feuille adhésive qui perdrait de son adhérence.
 Ne grattez jamais la feuille adhésive avec une éponge à récurer.
 Evitez d’étirer ou de plier la feuille adhésive quand vous la nettoyez.

Séchage

Laissez-la sécher complètement sans l’exposer au soleil.

Nettoyer le capuchon de tête

Détachez le capuchon de la tête et retirez la saleté et la poussière de la surface et de l’intérieur du capuchon. 
Si vous imprimez sans retirer la saleté et la poussière du capuchon, les instruments à graver risquent d’être 
endommagés et la qualité d’impression décevante. 
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3–2 Réglages

Régler la force de frappe de l’aiguille

Vous pouvez régler la force de frappe de l’aiguille avec “MPX-90M Head Manager”. Pour régler l’aiguille, il faut 
graver le motif illustré. Préparez un support de test (laiton) ou un autre support mesurant environ 60mm x 60mm.

Motif de test

Procédure

 Lancez “MPX-90M Head Manager”.
 "Lancer le logiciel" à la p. 22

 Mettez la machine sous tension.
"Etape 1: Mise sous tension" à la p. 27

Cliquez sur [Readjust Pin].
Suivez ensuite les consignes affichées à l’écran pour 
régler l’aiguille.

 Installez un support pour le test de gravure sur la 
feuille adhésive et la table.
 Utilisez un capuchon de tête.
Si le motif de test ne peut pas être imprimé, voyez les 
sections suivantes.
 �"La gravure n’est pas effectuée à l’emplacement voulu" à la p. 67

 Quand vous avez terminé, cliquez sur .
La fenêtre se ferme.
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Régler le point d’origine

Si le texte ou l’image n’est pas placé à la position voulue, le point d’origine de la machine n’est pas bien réglé. 
Réglez le point d’origine de la façon suivante.

Procédure

 Lancez “MPX-90M Head Manager”.
 “Ho"Lancer le logiciel" à la p. 22

Cliquez sur [Adjust Origin].
L’assistant “Adjust Origin” s’affiche.

Assistant “Adjust Origin”

Suivez ensuite les consignes affichées à l’écran pour 
effectuer le réglage.
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3–3 Remplacement des pièces soumises à l’usure

Cycle de remplacement du capuchon de tête

Le capuchon de tête doit être remplacé quand son extrémité (voyez l’illustration ci-dessous) est usée. Remplacez 
le capuchon usé par un neuf.
Le degré d’usure varie selon les conditions d’impression. Si vous sélectionnez souvent le réglage “Island Fill” 
ou si vous gravez des traits sur de l’aluminium ou une matière similaire, le capuchon s’use beaucoup plus vite 
à cause de l’irrégularité de la surface qui en résulte. Vérifiez régulièrement l’état du capuchon de tête pour le 
remplacer dès que nécessaire.
* “Island fill” est une méthode d’impression de caractères et d’objets (non remplis) par traits placés à intervalles 

réguliers. Pour en savoir plus, voyez l’aide en ligne de METAZAStudio (“Commands” – menu “Format” – 
“Font” – fenêtre de dialogue “Properties”).
 "Etape 1: Installer l’instrument à graver" à la p. 35

Le capuchon doit être remplacé

Le capuchon doit être remplacéLe capuchon doit être remplacé

Onglets Onglets

Usure

Usure

Encoche
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Remplacement de la tête

Dans les cas suivants, la tête doit être remplacée.
 La tête a atteint la fin de sa durée de vie.
 L’aiguille est usée.

Indications générales sur la durée de vie de la tête

Vous pouvez imprimer environ 4000 plaques avec une tête dans les conditions suivantes.
Matériel utilisé: MD-NI (plaque Roland en plaqué nickel)
Surface de gravure: 30mm x 23mm
Mode d’impression: Photo
Taux de gravure: 35% (25.000 points par plaque)

Pour les symboles 2D
De 60.000 à 100.000 symboles de 3mm x 3mm (H x L) peuvent être imprimés.
* Selon le réglage de “METAZAStudio”.

Un message indiquant la durée de vie de la tête s’affiche également dans “METAZAStudio”.

Cliquez sur [OK] pour faire disparaître le message. Cliquez sur [Details] pour afficher “MPX-90M Head Manager”.
 "Vérifier l’état de l’aiguille graveuse" à la p. 52

Vérifier l’état de l’aiguille graveuse

Vous pouvez vérifier l’état de l’aiguille avec “MPX-90M Head Manager”.

Procédure

 Lancez “MPX-90M Head Manager”.
 "Lancer le logiciel" à la p. 22
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3–3 Remplacement des pièces soumises à l’usure



Indique l’utilisation (l’usure) de l’aiguille. Le niveau d’usure 
progresse en fonction de l’utilisation de l’aiguille. La vitesse 
de la progression dépend du matériel utilisé pour la gravure.

Rafraîchit l’écran en incluant les 
dernières informations.

Mettez la machine sous tension.
 "Etape 1: Mise sous tension" à la p. 27

Le niveau d’usure de l’aiguille est indiqué sous “The 
amount of Pin usage” dans “MPX-90M Head Manager” 
Remplacez la tête dans les cas suivants.
 L’indicateur d’usure est dans le rouge.
 L’indicateur d’usure n’est pas dans le rouge mais 
l’impression n’est pas bonne ou les images sont 
irrégulières.
L’usure de l’aiguille n’est pas la seule raison d’une qualité 
d’impression médiocre ou irrégulière. Voyez les pages 
suivantes pour trouver l’origine du problème. Si le 
problème est dû à l’usure de l’aiguille, remplacez la tête.
 "L’impression n’est pas belle" à la p. 69, "L’image est irrégulière." 

à la p. 69

Remplacement de la tête

Pour changer la tête, utilisez l’application “MPX-90M Head Manager”. Le motif test ci-dessous est imprimé lors 
du remplacement de la tête. Préparez un support de test (laiton) livré avec la nouvelle tête (MPH-90) ou un 
autre support d’au moins 60mm x 60mm.
Remarque: La tête de remplacement est disponible en option. Contactez votre revendeur Roland DG agréé.

Motif de test

Important
 La procédure de remplacement ne peut jamais être interrompue.
 N’utilisez jamais une tête dont l’aiguille est usée.
 N’utilisez pas une tête qui a été démontée de la machine.

Procédure

 Lancez “MPX-90M Head Manager”.
 "Lancer le logiciel" à la p. 22
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 Mettez la machine sous tension.
 "Etape 1: Mise sous tension" à la p. 27

 Cliquez sur [Replace Head].
Suivez ensuite les consignes affichées à l’écran pour 
régler l’aiguille.

 �Installez un support pour le test de gravure sur la 
feuille adhésive et la table.

 Utilisez un capuchon de tête.
 "Etape 1: Installer l’instrument à graver" à la p. 35

Si le motif de test ne peut pas être imprimé, voyez les 
sections suivantes.
 "La gravure n’est pas effectuée à l’emplacement voulu" à la p. 67

 Quand vous avez terminé, cliquez sur .
La fenêtre se ferme.
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4–1 Opérations avancées

Créer directement des symboles 2D

Vous pouvez créer directement des symboles 2D avec “METAZAStudio” ce qui évite de passer par un fichier CSV.
Vous pouvez utiliser “METAZAStudio” pour modifier le code d’un symbole 2D que vous avez créé et créer un 
autre symbole 2D.

Procédure

 Lancez “METAZAStudio”.
 "Lancer le logiciel" à la p. 22

Si “METAZAStudio” tourne, cliquez sur .

 Dans la fenêtre de dialogue “Select Material”, 
sélectionnez la matière de l’instrument à 
graver.
Si vous voulez préciser la matière de l’instrument, 
désélectionnez la case “Use printer driver settings”. 
Si vous utilisez une matière qui ne figure pas dans la 
liste, vous pouvez créer une nouvelle entrée.
 �"Sauvegarder un type de matière et régler la force de 

frappe" à la p. 59

�Si vous souhaitez utiliser les réglages du pilote, 
cochez la case “Use printer driver settings”.

 Cliquez sur [OK].

 Cliquez sur .
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4–1 Opérations avancées

 Maintenez le bouton gauche de la souris enfoncé et faites glisser la souris en diagonale vers 
le bas sur la zone de travail* dans “METAZAStudio”.
Vous délimitez ainsi une zone de dessin pour un symbole 2D et la fenêtre de dialogue “Code Input” apparaît. 
* Zone de travail= zone noire à l’écran

 Entrez un code puis cliquez sur [OK].
Entrez un code pour le symbole 2D.

 Cliquez sur [Object] > [Move to Center].
Le centre du symbole 2D est placé au centre de la 
zone de travail.

Cette étape est importante car elle détermine la 
position d’impression réelle.
La machine utilise la position centrale comme point 
de référence pour l’impression. Cela signifie que 
le centre de la zone de travail de “METAZAStudio” 
sert de point de référence pour la machine. Il n’est 
possible d’obtenir un résultat prédictible que si le 
centre du symbole 2D se trouve au centre de la zone 
de travail et correspond au point de référence de 
l’impression.
Vous pouvez obtenir des résultats convenables quand 
le centre du symbole 2D n’est pas exactement au 
centre mais la coïncidence entre le centre du sym-
bole et le point de référence de l’impression facilite le 
positionnement du texte ou de l’image.
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 Cliquez sur .
La boîte de dialogue “Properties” s’affiche.

Tant que la zone de dessin pour le symbole 2D n’est pas sélectionnée, vous ne pouvez pas cliquer sur . Si vous 
ne pouvez pas cliquer sur , cliquez sur  puis cliquez (sélectionnez) sur la zone de dessin du symbole 2D.

 Entrez les caractéristiques (dimensions etc.) du symbole 2D.
Pour en savoir plus sur les différents paramètres, voyez l’aide en ligne de “METAZAStudio” (“Commands” 
– menu “Object” – “Properties” – fenêtre de dialogue “Properties”).

 "Affichage de l’aide en ligne du logiciel" à la p. 23

Quand les réglages sont terminés, cliquez sur [OK].

Les données d’impression sont prêtes. Passez à la section "Etape 1: Installer l’instrument à graver" à la p. 35.

Si vous cliquez sur [Change] à la 
page onglet “2D Symbol”, la fenêtre 
de dialogue “Code Input” apparaît. 
En utilisant le fichier de symbole 2D 
que vous avez créé directement avec 
“METAZAStudio”, vous pouvez créer un 
fichier avec un code différent. 
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Sauvegarder un type de matière et régler la force de frappe

En effectuant la gravure avec une force de frappe adaptée à la matière de l’instrument à graver, vous obtenez 
des résultats optimaux. Le pilote METAZA de la machine propose des préréglages pour différentes matières 
ainsi que des réglages de frappe appropriés. Vous pouvez y ajouter d’autres matières (compositions) et leur 
force de frappe optimale. Vous pouvez également ajuster ultérieurement la force de frappe pour des matières 
que vous avez sauvegardées afin d’améliorer la gravure.

Procédure

 Affichez la fenêtre “Printing Preferences” du pilote METAZA.
 "Ouvrir la fenêtre ‘Printing Preferences’ du pilote METAZA" à la p. 21

  Cliquez sur l’onglet “Image Correction”.
 �Sous “Material”, sélectionnez une matière 
personnalisé (de “a” à “h”).

 Sélectionnez le mode d’impression.

Text Pour graver du texte et des images avec des contours clairs

Photo Pour graver des photos et des images avec des dégradés

HighResolution Pour graver de façon lisible des caractères ou des motifs de taille réduite

Others Pour régler vous-même la résolution et d’autres paramètres

 Aide en ligne du pilote METAZA (onglet “Correction”)

 Cliquez sur [Details].
La fenêtre de dialogue “Details” apparaît.
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  �Entrez un nom pour la matière (composition) 
à sauvegarder.

 Réglez les paramètres “Speed/Impact”.
Les résultats de l’impression varient selon la dureté 
de la matière. Effectuez les réglages en fonction de 
la matière du support.
 Aide en ligne du pilote METAZA (onglet “Correction” > fenêtre 

de dialogue “Details”)

Impact–MIN

Entrez ici la force de frappe minimum pour l’impression d’une image. 
Augmentez le réglage si les zones foncées de l’image ne sont pas gravées.
Diminuez le réglage si les zones foncées sont trop claires ou si la gravure 
est effectuée avec une force excessive.

Impact–MAX

Entrez ici la force de frappe maximum pour l’impression d’une image. 
Augmentez ce réglage si les zones claires de l’image ou si la gravure 
globale est effectuée avec une force insuffisante. Diminuez le réglage si 
les zones claires sont gravées avec une force excessive.

Vector Impact Entrez ici la force de frappe maximum pour l’impression d’un trait.

 Sélectionnez “Advance”.
 “Advance” n’est disponible que si vous choisissez “Other” sous  à l’étape .

 Aide en ligne du pilote METAZA (onglet “Correction” > fenêtre de dialogue “Details”)

OutputResolution Vous pouvez préciser le nombre de points par pouce. Plus le nombre de 
points est important, plus l’image est précise. 

Drafting Si vous sélectionnez “ON”, vous pouvez réduire la résolution d’image par 
paliers d’un point. 

 Cliquez sur [OK].
La fenêtre de dialogue “Advance” se ferme.

Changer les réglages de base du pilote METAZA
Procédure

 Windows 7
Dans le menu “Démarrer” ( ), cliquez sur [Panneau de configuration] > [Matériel et son] > 
[Périphériques et imprimantes].

Windows Vista
Dans le menu “Démarrer” ( ), cliquez sur [Panneau de configuration] > [Matériel et son] > 
[Imprimantes].

Windows XP
Dans le menu “Démarrer” (  ), cliquez sur [Panneau de configuration] > [Imprimantes et 
autres périphériques] > [Imprimantes et télécopieurs].
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  �Faites un clic droit sur l’icône [Roland 
MPX‑90M]. 

 Cliquez sur [Printing Preferences].
La fenêtre de réglage du pilote METAZA s’affiche. 
Changez les réglages selon vos besoins.

 Quand les réglages sont terminés, cliquez 
sur [OK].

Description

La fenêtre de réglage du pilote METAZA propose toute une série de paramètres permettant notamment de 
régler la taille du support et l’unité de mesure. Les réglages de base restent en vigueur lorsque vous effectuez 
les réglages décrits ci-dessus.
Vous pouvez changer ces réglages avec “METAZAStudio” (dans le menu “File”, cliquez sur [Print Setup]> [Pro-
perties] pour afficher la fenêtre “Printing Preferences” illustrée à l’étape ) mais ces changements sont perdus 
lorsque vous redémarrez “METAZAStudio”.

Créer et modifier des caractères à traits

Caractères à traits et SFEdit2

Qu’est-ce que des caractères à traits?
Tous les caractères à traits (“stroke character”) sont constitués de polylignes et de lignes.

Qu’est-ce que ‘SFEdit2’?
Le logiciel “SFEdit2” permet de créer et de modifier des polices de caractères à traits. Comme tous les caractères 
à traits sont constitués de polylignes et de lignes, vous pouvez ajouter ou supprimer des points d’ancrage et 
ajouter des segments de ligne. “METAZAStudio” permet d’utiliser des polices de caractères à traits, créées et 
modifiées avec “SFEdit2”.
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Créer et sauvegarder une police de caractères à traits

Procédure

 Lancez “SFEdit2”.
 "Affichage de l’aide en ligne du logiciel" à la p. 23

 Cliquez sur [File]> [New…].
La fenêtre de dialogue “Select Base Font” apparaît.

  �Sélectionnez la police devant servir de base 
à la police de caractères à traits.

 Cliquez sur [OK].
Une police de caractères à traits est automatiquement 
créée.

 Cliquez sur .
La fenêtre de dialogue “Save” apparaît.

 


 Entrez un nom pour la nouvelle police de 

caractères à traits.
Pour faciliter son identification, intégrez le nom de 
la police originale dans le nom de la nouvelle police. 
Exemple: “MS P Gothic_SF” (“SF” signifie “stroke font”= 
police de caractères à traits)

 Cliquez sur [OK].
La nouvelle police de caractères à traits est sauvegardée.
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 Cliquez sur .

Utiliser une police de caractères à traits dans ‘METAZAStudio’

Les deux opérations suivantes doivent avoir été effectuées au préalable.
 Créer une police de caractères à traits avant l’installation de “SFEdit2”

La fenêtre illustrée apparaît quand vous l’installez. Si vous n’avez pas créé de police de caractères à traits 
lors de l’installation, recommencez l’installation de “SFEdit2” et créez une police de caractères à traits.

 "Installation du pilote et des logiciels" à la p. 18, "Installer un logiciel séparément" à la p. 76

 Créer une nouvelle police de caractères à traits
 "Créer et sauvegarder une police de caractères à traits" à la p. 62

1. Transformer les caractères entrés en caractères à traits 

 Entrez des caractères avec “METAZAStudio”.
Pour savoir comment entrer des caractères, voyez l’aide en ligne de “METAZAStudio”.

 "Affichage de l’aide en ligne du logiciel" à la p. 23

 Cliquez sur .
La boîte de dialogue “Properties” s’affiche.
Si le cadre de texte contenant les caractères entrés n’est pas sélectionné, vous ne pouvez pas sélectionner 

. Veillez donc à sélectionner le cadre de texte.
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  Cliquez sur l’onglet “Format”.
 Sélectionnez “Stroke”.

Sous “Font”, vous ne pouvez plus sélectionner que des caractères à traits (“stroke characters”).
 Sélectionnez des caractères à traits.
 Cliquez sur [OK].

Les caractères entrés sont transformés en caractères à traits. Ils utilisent la police de caractères à traits 
sélectionnée à l’étape .

2. Modifier les caractères à traits

  Cliquez sur .
 Cliquez sur le caractère à traits à modifier.

Huit points de référence apparaissent autour du caractère à traits.
 Cliquez sur [Edit]> [Stroke Font]> [Edit Stroke…].

Le logiciel “SFEdit2” démarre.
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 Dans la liste de caractères, cliquez sur le caractère à traits à modifier.
Ce caractère à traits est affiché dans la forme virtuelle et peut être modifié. Changez la position et la 
forme du caractère à traits.

 Aide en ligne de “SFEdit2” (“Editing Polylines”)

Liste de caractères

  Cliquez sur .
La nouvelle version remplace le caractère à traits 
sélectionné.

 Cliquez sur .
Vous quittez l’application “SFEdit2”.
Le caractère modifié remplace l’ancienne version.

Autres opérations avec ‘METAZAStudio’

“METAZAStudio” ne permet pas seulement de créer des symboles 2D et des données de texte. Il propose 
également les fonctions suivantes.

 Sauvegarde de formes particulières de support
 Création et modification de caractères et de formes
 Importation de fichiers d’image

Pour en savoir plus sur l’utilisation de “METAZAStudio”, voyez l’aide en ligne du logiciel.
 "Affichage de l’aide en ligne du logiciel" à la p. 23
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L’interrupteur/bouton d’avance clignote.

Avez-vous mis la machine sous tension alors que la tête est bloquée à une hauteur déterminée? 

Si vous mettez la machine sous tension alors que la tête est bloquée à une hauteur déterminée, l’opération 
initiale s’arrête. Si la machine poursuit l’opération initiale alors qu’un instrument à graver est installé, la surface 
de l’instrument risque d’être rayée et/ou l’aiguille graveuse endommagée.
Tournez une fois la molette dans le sens inverse des aiguilles d’une montre. Puis poussez la butée de la tête 
de contre l’anneau et serrez la molette. Appuyez sur l’interrupteur/bouton d’avance pour achever l’opération 
initiale. Le témoin cesse alors de clignoter et reste allumé.

Le centre de la molette 
doit se trouver juste au-
dessus du triangle. 

Anneau

Molette

Butée

Desserrer

Desserrer
Serrer

Serrer

Si vous n’utilisez pas de capuchon de tête, avez-vous réglé la hauteur de la tête?

L’extrémité de la tête heurte la surface de l’instrument à graver. Maintenez l’interrupteur/bouton d’avance 
enfoncé au moins une seconde pour couper l’alimentation.
Réglez la position de la tête en fonction de la hauteur de la pièce à graver et bloquez correctement la tête 
avec la molette. Si la tête est trop basse, son extrémité heurte la pièce à graver.

 "Etape 1: Installer l’instrument à graver" à la p. 35

Avez-vous relevé la tête lors de la mise sous tension?

Comme la tête est relevée à la hauteur maximum, la machine considère que la pièce à graver est trop haute 
et ne répond pas aux critères pour l’impression. Maintenez l’interrupteur/bouton d’avance enfoncé au moins 
une seconde pour couper l’alimentation.
Quand vous mettez la machine sous tension, veillez à ne pas toucher la tête.

La surface d’impression a-t-elle des différences de niveau trop importantes?

Maintenez l’interrupteur/bouton d’avance enfoncé au moins une seconde pour couper l’alimentation.
Vérifiez les critères auxquels les pièces doivent répondre pour pouvoir être gravées et utilisez des instruments 
répondant à ces critères.

 "Etape 3: Préparer l’instrument à graver" à la p. 28
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Avez-vous installé un instrument sans utiliser la table fournie (ou l’étau)? 

Maintenez l’interrupteur/bouton d’avance enfoncé au moins une seconde pour couper l’alimentation.
Si vous installez un instrument de faible hauteur sans utiliser la table ou l’étau fourni, la machine considère 
que la pièce à graver ne répond pas aux critères pour l’impression. Installez l’instrument sur la table ou dans 
l’étau fourni.

 "Etape 1: Installer l’instrument à graver" à la p. 35

La molette s’est-elle desserrée?

Maintenez l’interrupteur/bouton d’avance enfoncé au moins une seconde pour couper l’alimentation.
Si la molette se desserre quand vous imprimez sans capuchon, la tête se décale et sa hauteur ne correspond 
plus à celle de la surface d’impression. Réglez la hauteur de la tête puis serrez convenablement la molette.

 "Etape 1: Installer l’instrument à graver" à la p. 35

La machine ne fonctionne pas alors que des données d’impression lui sont envoyées

La machine est-elle sous tension?

Vérifiez que l’interrupteur/bouton d’avance est allumé. Si ce n’est pas le cas, appuyez sur l’interrupteur/bouton 
d’avance pour mettre la machine sous tension.

 "Etape 1: Mise sous tension" à la p. 27

Le cordon d’alimentation est-il correctement branché?

S’il n’est pas branché correctement, branchez-le convenablement.
 "Connexion du cordon d’alimentation" à la p. 16

Le câble de connexion avec l’ordinateur est-il correctement branché?

Vérifiez si le câble de connexion est débranché.

La gravure n’est pas effectuée à l’emplacement voulu

Avez-vous placé l’instrument à graver au bon endroit?

Si ce n’est pas le cas, installez l’instrument au bon endroit.
 "Etape 1: Installer l’instrument à graver" à la p. 35

Le point d’origine de la machine s’est-il décalé?

Si le point d’origine de la machine est décalé, le texte ou l’image n’est pas gravée au bon endroit. Réglez le 
point d’origine avec “MPX-90M Head Manager”.

 "Régler le point d’origine" à la p. 50
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La machine fonctionne mais rien n’est gravé.

L’instrument à graver répond-il aux critères requis pour la gravure?
Utilisez un instrument pouvant être gravé.

 "Etape 3: Préparer l’instrument à graver" à la p. 28

Si vous n’utilisez pas de capuchon, avez-vous réglé correctement la hauteur de la tête en 
fonction de celle de l’instrument?

Vérifiez si vous avez réglé correctement la hauteur de la tête en fonction de celle de l’instrument. La gravure 
est impossible si la hauteur de la tête n’est pas réglée en fonction de celle de l’instrument. Réglez correctement 
la hauteur de la tête et serrez bien la molette.

 "Etape 1: Installer l’instrument à graver" à la p. 35

L’aiguille est-elle pliée ou cassée?

Si rien n’est gravé alors que vous avez vérifié l’emplacement du support, les réglages de support et la hauteur 
de la tête, l’aiguille est peut-être cassée ou pliée. Changez d’aiguille et faites un test de gravure. Si la gravure 
est réalisée, l’aiguille que vous utilisiez était pliée ou cassée. Travaillez avec la nouvelle aiguille.

 "Remplacement de la tête" à la p. 52

Pliée ou casséePliée ou casséeEn bon état

Vous ne pouvez pas sélectionner la matière de l’objet à graver avec ‘METAZAStudio’ 

La case “Use printer driver settings” est-elle cochée?

Si la case “Use printer driver settings” est cochée dans la fenêtre de dialogue “Select Material”, vous ne pouvez 
pas choisir la matière. Désélectionnez la case “Use printer driver settings”.

Utilisez-vous un fichier créé par une ancienne version de ‘METAZAStudio’?

Vous ne pouvez pas sélectionner le type de matière pour un fichier créé avec une version de “METAZAStudio” 
antérieure à la version 2.00. Sauvegardez le fichier avec “METAZAStudio” version 2.00 ou plus récente et 
sélectionnez la matière du support.
Vous pouvez vérifier la version de votre application “METAZAStudio” dans la fenêtre affichée en sélectionnant 
le menu “Help” → “Version” dans “METAZAStudio”.
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L’impression n’est pas belle

Le réglage de matière est-il correct?

Spécifiez la matière de l’instrument dans “METAZAStudio”.
En présence de supports de composition identique, la force de gravure –et avec elle la qualité– peut fluctuer 
en raison de divers facteurs: méthode de fonte, pureté du matériau, présence d’un revêtement etc. Dans ce 
cas, affinez le réglage de force de frappe selon le support.

 "Sauvegarder un type de matière et régler la force de frappe" à la p. 59

L’image imprimée est-elle claire?

Si l’image n’est pas claire, réglez la luminosité de l’image.
Effectuez une impression en augmentant progressivement la valeur “Gamma” ou “Brightness” dans la fenêtre 
de prévisualisation. Dans ce cas, ne retirez pas le support mais recommencez la gravure au même endroit. 
Poursuivez la gravure tout en changeant les réglages jusqu’à ce que vous obteniez le résultat voulu.

 Aide en ligne pour METAZAStudio> “Commands”> “File”> Print Preview

Les nuances de gris sont-elles gravées correctement?

Si les nuances de gris ne sont pas gravées correctement, réglez la force de frappe dans la fenêtre de réglage du 
pilote METAZA (paramètre “Details” sous l’onglet “Image Correction”) Ne modifiez pas la valeur “Impact–MAX”. 
En revanche, corrigez progressivement la valeur “Impact–MIN”. Dans ce cas, ne retirez pas le support mais 
recommencez la gravure au même endroit. Poursuivez la gravure tout en changeant les réglages du pilote 
METAZA jusqu’à ce que vous obteniez le résultat voulu.

 "Sauvegarder un type de matière et régler la force de frappe" à la p. 59

L’aiguille est-elle usée?

Une aiguille usée ne produit pas une belle gravure. Réglez l’aiguille ou remplacez-la.
 "Remplacement de la tête" à la p. 52

L’image est irrégulière.

La surface du support est-elle un peu irrégulière?/La surface du support est-elle inclinée?

Si vous n’avez pas fixé de capuchon, fixez-en un avant d’effectuer la gravure. Si vous utilisez un support pouvant 
être endommagé par le capuchon, remplacez-le par un instrument ayant une surface de gravure plane.

 "Précautions lors de l’utilisation d’un capuchon de tête" à la p. 36

Résultats de la gravure après plusieurs passages et réglages finaux
Pour obtenir le résultat voulu, il peut arriver que vous deviez recommencer la gravure à plusieurs 
reprises tout en changeant progressivement les réglages. Si vous utilisez ensuite les réglages finaux 
pour graver un autre instrument en n’effectuant qu’un seul passage, vous n’obtiendrez pas tout à fait 
le même résultat que celui obtenu après plusieurs passages.
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Les parties foncées de l’image sont-elles irrégulières?

Recommencez la frappe au même endroit peut améliorer la qualité. Recommencez la gravure en changeant 
les réglages des paramètres “Gamma”, “Brightness” ou “Contrast” dans la fenêtre de prévisualisation.

 Aide en ligne pour METAZAStudio> “Commands”> “File”> Print Preview

Avez-vous effectué une gravure bidirectionnelle?

La gravure bidirectionnelle raccourcit le temps de gravure mais la qualité peut s’en ressentir. Dans ce cas, 
désactivez l’option “Bidirection” dans la fenêtre de réglage du pilote et recommencez la gravure.

 Aide en ligne pour le pilote METAZA (onglet “Material”)

L’aiguille est-elle usée?

Une aiguille usée ne produit pas une belle gravure. Réglez l’aiguille ou remplacez-la.
 "Remplacement de la tête" à la p. 52

L’image est toujours plus claire au même endroit.

La surface d’impression affiche-t-elle une différence de niveau excessive?

Si l’image est toujours plus claire au même endroit bien que vous utilisiez un capuchon, les variations de hauteur 
de la zone à graver sont peut-être excessives. Vérifiez les critères auxquels les instruments doivent répondre 
pour pouvoir être gravés et utilisez des instruments répondant à ces critères. En outre, il est impossible de 
garantir la qualité de l’image si vous imprimez des données photographiques sur un support courbe.

 "Etape 3: Préparer l’instrument à graver" à la p. 28

La machine peut être légèrement inclinée.

Si le côté avant droit de vos images, par exemple, est toujours trop clair, la machine n’est peut-être pas de 
niveau. Le réglage du niveau de la machine peut améliorer la qualité de l’image. Cela ne corrige évidemment le 
problème que si le défaut se présente toujours au même endroit (et ne varie pas selon le support ou l’image). 
Nous recommandons vivement l’utilisation d’un capuchon.

Procédure

 Placez un support de test sur la table.
Servez-vous de la feuille adhésive et placez le support au centre de la table. Si vous avez déjà épuisé les 
supports de test fournis, préparez un support d’au moins 60mm de côté dont les reliefs ne dépassent 
pas 0,05mm. Imprimez le motif de test sans capuchon de tête.

 "Etape 1: Installer l’instrument à graver" à la p. 35

 Dans le menu “Démarrer” ( ), cliquez sur [Périphériques et imprimantes] (ou [Imprimantes 
et télécopieurs]).
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 Faites un clic droit sur l’icône “Roland MPX‑90M” 
puis cliquez sur “Printing Preferences”.
La fenêtre “Printing Preferences” du pilote METAZA 
s’ouvre.

 Cliquez sur [Test Print] sous l’onglet “Option”.
La machine effectue un test de gravure.


Back

Front

RightLeft

Prenez note des endroits où le test montre 
des parties non continues ou invisibles en 
vous aidant des lignes graduées.
Il s’agit donc de noter les coordonnées de l’endroit 
où la gravure pose problème (“Front”, “Back”, “Left” 
et “Right”).
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  Cochez “Correct slope”.
 �Entrez les valeurs que vous avez notées sous 
 dans la fenêtre du pilote.

 Cliquez sur [OK].

Installer le pilote METAZA séparément

Procédure

 Activez Windows en tant qu’administrateur ou membre du groupe d’administrateurs.

 Insérez le CD-ROM de logiciels Roland dans l’ordinateur.
(Windows Vista/7 uniquement: Quand la fenêtre de lecture automatique apparaît, cliquez 
sur [Run menu.exe].)
Le menu de configuration s’affiche automatiquement.

 Désinstallez le pilote METAZA s’il a déjà été installé.
 "Désinstaller le pilote METAZA" à la p. 78

Passez à l’étape  si le pilote METAZA n’est pas installé ou s’il est désinstallé.

 Cliquez sur [Custom Install].

Vous pouvez installer simultanément le pilote et les logiciels. Pour savoir comment faire, voyez 
"Installation du pilote et des logiciels" à la p. 18. 
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 Cliquez sur [Install] en face de “METAZA Driver”.

 Sélectionnez “Install”, le nom du modèle (“Ro-
land MPX-90M”), le port “USB” puis cliquez 
sur [Start].
L’utilitaire d’installation du pilote démarre. Effectuez 
l’installation en suivant les consignes affichées à 
l’écran.

Windows Vista ou 7

Quand la fenêtre illustrée apparaît, cliquez sur [Installer 
ce pilote quand même].

Windows XP

Quand la fenêtre illustrée apparaît, cliquez sur 
[Continuer].
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 Quand la fenêtre illustrée apparaît, cliquez sur 
[Terminer].

 Cliquez sur  du menu de configuration.

 Retirez le CD-ROM du lecteur.

 Utilisez un câble USB pour brancher la machine à l’ordinateur.
Utilisez le câble USB fourni. N’utilisez pas de hub USB.

Windows Vista ou 7
Le pilote est installé automatiquement.

Windows XP
 

Sélectionnez “Non” et cliquez sur [Suivant].

 
Choisissez [Installer le logiciel automatiquement] 
puis cliquez sur [Suivant].
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Cliquez sur [Terminer].

Si l’affichage suivant apparaît durant l’installation
Cliquez sur [Continuer].

Ejectez le CD-ROM puis cliquez sur [Back] et 
recommencez à partir du dernier affichage.
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Installer un logiciel séparément

Procédure

 Activez Windows en tant qu’administrateur ou membre du groupe d’administrateurs.

 Insérez le CD-ROM de logiciels Roland dans l’ordinateur.
(Windows Vista/7 uniquement: Quand la fenêtre de lecture automatique apparaît, cliquez 
sur [Run menu.exe].)
Le menu de configuration s’affiche automatiquement.

 Cliquez sur [Custom Install].

 Cliquez sur [Install] à côté du logiciel à installer.
 "Logiciels que vous pouvez installer et configurer" à la p. 17

Pour en savoir plus sur l’installation du pilote METAZA, 
voyez "Installer le pilote METAZA séparément" à la p. 72.

 Suivez les instructions affichées pour installer les logiciels.
(Windows Vista/7 uniquement: Quand la fenêtre “Contrôle de compte d’utilisateur” apparaît, cliquez sur 
[Continuer] et installez les logiciels.)

 A la fin de l’installation, cliquez sur  
dans le menu de configuration.

 Retirez le CD-ROM du lecteur.

Vous pouvez installer simultanément le pilote et les logiciels. Pour savoir comment faire, voyez 
"Installation du pilote et des logiciels" à la p. 18. 
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Impossible d’installer le pilote METAZA

Si l’installation du pilote s’interrompt ou si l’assistant n’apparaît pas quand vous branchez le PC à la machine 
avec un câble USB, suivez la procédure adéquate, décrite ci-dessous.

Windows 7

1. Utilisez un câble USB pour brancher la machine au PC puis mettez la machine sous tension.
2. Si la fenêtre “Assistant Matériel détecté” apparaît, cliquez sur [Annuler] pour la refermer. Débranchez tous les câbles USB 
d’imprimantes et de tout périphérique autre que cette machine.
3. Cliquez sur le menu [Démarrer] puis faites un clic droit sur [Poste de travail]. Cliquez sur [Propriétés].
4. Cliquez sur [Gestionnaire de périphériques]. Quand la fenêtre “Contrôle de compte d’utilisateur” apparaît, cliquez sur [Continuer].
La fenêtre “Gestionnaire de périphériques” apparaît.
5. Sous le menu [Afficher], cliquez sur [Afficher les périphériques cachés].
6. Double-cliquez sur [Imprimantes] ou [Autres périphériques] dans la liste. Cliquez sur le nom du modèle que vous utilisez ou 
sur [Périphérique inconnu], selon ce qui apparaît sous l’élément choisi.
7. Cliquez sur [Supprimer] dans le menu “Action”.
8. Dans la fenêtre affichant la demande de confirmation pour la désinstallation, sélectionnez l’option de suppression du pilote 
pour ce périphérique puis cliquez sur [OK] pour refermer le gestionnaire de périphériques.
9. Débranchez le câble USB branché à la machine puis redémarrez Windows.
10. Désinstallez le pilote METAZA.
Voyez "Désinstaller le pilote METAZA" à la p. 78 et suivez la procédure pour Windows 7 à partir de l’étape 3 pour désinstaller le 
pilote METAZA.
11. Installez à nouveau le pilote en suivant les explications données sous "Installer le pilote METAZA séparément" à la p. 72.

Windows Vista

1. Utilisez un câble USB pour brancher la machine au PC puis mettez la machine sous tension.
2. Si la fenêtre “Assistant Matériel détecté” apparaît, cliquez sur [Annuler] pour la refermer. Débranchez tous les câbles USB 
d’imprimantes et de tout autre périphérique autre que cette machine.
3. Cliquez sur le menu [Démarrer] puis faites un clic droit sur [Poste de travail]. Cliquez sur [Propriétés].
4. Cliquez sur [Gestionnaire de périphériques]. Quand la fenêtre “Contrôle de compte d’utilisateur” apparaît, cliquez sur [Continuer].
La fenêtre “Gestionnaire de périphériques” apparaît.
5. Sous le menu [Afficher], cliquez sur [Afficher les périphériques cachés].
6. Double-cliquez sur [Imprimantes] ou [Autre périphérique] dans la liste. Cliquez sur le nom du modèle que vous utilisez ou 
sur [Périphérique inconnu], selon ce qui apparaît sous l’élément choisi.
7. Cliquez sur [Supprimer] dans le menu “Action”.
8. Dans la fenêtre affichant la demande de confirmation pour la désinstallation, sélectionnez l’option de suppression du pilote 
pour ce périphérique puis cliquez sur [OK] pour refermer le gestionnaire de périphériques.
9. Débranchez le câble USB branché à la machine puis redémarrez Windows.
10. Désinstallez le pilote METAZA.
Voyez "Désinstaller le pilote METAZA" à la p. 78 et suivez la procédure pour Windows Vista à partir de l’étape 3 pour désinstaller 
le pilote METAZA.
11. Installez à nouveau le pilote en suivant les explications données sous "Installer le pilote METAZA séparément" à la p. 72.

Windows XP

1. Utilisez un câble USB pour brancher la machine au PC puis mettez la machine sous tension.
2. Si la fenêtre “Assistant Matériel détecté” apparaît, cliquez sur [Terminer] pour la refermer. Débranchez tous les câbles USB 
d’imprimantes et de tout autre périphérique autre que cette machine.
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3. Cliquez sur le menu [Démarrer] puis faites un clic droit sur [Poste de travail]. Cliquez sur [Propriétés].
4. Cliquez sur l’onglet [Matériel] puis sur [Gestionnaire de périphériques].
La fenêtre “Gestionnaire de périphériques” apparaît.
5. Sous le menu “Afficher”, cliquez sur [Afficher les périphériques cachés].
6. Double-cliquez sur [Imprimantes] ou [Autre périphérique] dans la liste. Cliquez sur le nom du modèle que 
vous utilisez ou sur [Périphérique inconnu], selon ce qui apparaît sous l’élément choisi.
7. Cliquez sur [Supprimer] dans le menu “Action”.
8. Dans la fenêtre affichant la demande de confirmation pour la désinstallation, cliquez sur [OK].
9. Refermez la fenêtre du gestionnaire de périphériques et cliquez sur [OK].
10. Débranchez le câble USB branché à la machine puis redémarrez Windows.
11. Désinstallez le pilote METAZA.
Voyez "Désinstaller le pilote METAZA" à la p. 78 et suivez la procédure pour Windows XP à partir de l’étape 3 
pour désinstaller le pilote METAZA.
12. Installez à nouveau le pilote en suivant les explications données sous "Installer le pilote METAZA séparé-
ment" à la p. 72.

Désinstaller le pilote METAZA

Procédez comme suit pour désinstaller le pilote.

Windows 7

1. Mettez la machine hors tension et débranchez le câble USB reliant la machine au PC.
2. Ouvrez une session de Windows en tant qu’administrateur.
3. Cliquez sur [Démarrer], [METAZA Controller] puis [Désinstaller un programme].
4. Sélectionnez le pilote de la machine à désinstaller puis cliquez sur [Désinstaller].
5. Quand un message vous demande confirmation pour la désinstallation du pilote, cliquez sur [Oui].
6. Cliquez sur [Démarrer], [Tous les programmes], [Accessoires], [Exécuter] puis [Rechercher].
7. Sélectionnez le nom du lecteur ou du dossier où se trouve le pilote.*
8. Sélectionnez “SETUP.EXE”, cliquez sur [Ouvrir] puis sur [OK].
9. Quand la fenêtre “Contrôle de compte d’utilisateur” apparaît, cliquez sur [Continuer].
L’utilitaire d’installation du pilote démarre.
10. Cliquez sur [Désinstaller]. Sélectionnez la machine à désinstaller puis cliquez sur [Démarrer].
11. Quand l’écran affiche un message vous demandant de redémarrer le PC, cliquez sur [Oui].
La désinstallation est terminée après le redémarrage de l’ordinateur.

* �Si vous utilisez le CD-ROM, spécifiez un des dossiers suivants. (Le lecteur de CD est le lecteur D dans cet 
exemple.)

D:\Drivers\WIN7X64 (version à 64 bits)
D:\Drivers\WIN7X86 (version à 32 bits)
Si vous n’utilisez pas le CD-ROM, allez sur le site web de Roland DG (http://www.rolanddg.com/) et téléchargez 
le pilote de la machine à supprimer. Sélectionnez ensuite le dossier où vous avez placé le fichier téléchargé.

Windows Vista

1. Mettez la machine hors tension et débranchez le câble USB reliant la machine au PC.
2. Ouvrez une session de Windows en tant qu’administrateur.
3. Cliquez sur [Démarrer], [Panneau de configuration] puis [Désinstaller un programme].
4. Sélectionnez le pilote de la machine à désinstaller puis cliquez sur [Désinstaller].
5. Quand un message vous demande confirmation pour la désinstallation du pilote, cliquez sur [Oui].
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6. Cliquez sur [Démarrer], [Tous les programmes], [Accessoires], [Exécuter] puis [Rechercher].
7. Sélectionnez le nom du lecteur ou du dossier où se trouve le pilote.
8. Sélectionnez “SETUP.EXE”, cliquez sur [Ouvrir] puis sur [OK].
9. Quand la fenêtre “Contrôle de compte d’utilisateur” apparaît, cliquez sur [Continuer].
Le programme de configuration du pilote démarre.
10. Cliquez sur [Désinstaller]. Sélectionnez la machine à désinstaller puis cliquez sur [Démarrer].
11. L’écran affiche un message vous demandant de redémarrer le PC. Cliquez sur [Oui].
La désinstallation est terminée après le redémarrage de l’ordinateur.

* Si vous utilisez le CD-ROM, spécifiez un des dossiers suivants. (Le lecteur de CD est le lecteur D dans cet 
exemple.)
D:\Drivers\WINVISTAX64 (version à 64 bits)
D:\Drivers\WINVISTAX86 (version à 32 bits)
Si vous n’utilisez pas le CD-ROM, allez sur le site web de Roland DG (http://www.rolanddg.com/) et téléchargez 
le pilote de la machine à supprimer. Sélectionnez ensuite le dossier où vous avez placé le fichier téléchargé.

Windows XP

1. Mettez la machine hors tension et débranchez le câble USB reliant la machine au PC.
2. Activez Windows en tant qu’administrateur ou membre du groupe d’administrateurs.
3. Cliquez sur [Démarrer], [Panneau de configuration] puis [Désinstaller un programme].
4. Sélectionnez le pilote de la machine à désinstaller puis cliquez sur [Désinstaller].
5. Quand un message vous demande confirmation pour la désinstallation du pilote, cliquez sur [Oui].
6. Cliquez sur [Démarrer], [Tous les programmes], [Accessoires], [Exécuter] puis [Rechercher].
7. Sélectionnez le nom du lecteur ou du dossier où se trouve le pilote.
8. Sélectionnez “SETUP.EXE”, cliquez sur [Ouvrir] puis sur [OK].
Le programme de configuration du pilote démarre.
9. Cliquez sur [Désinstaller]. Sélectionnez la machine à désinstaller puis cliquez sur [Démarrer].
10. Quand l’écran affiche un message vous demandant de redémarrer le PC, cliquez sur [Oui].
La désinstallation est terminée après le redémarrage de l’ordinateur.

* Si vous utilisez le CD-ROM, spécifiez un des dossiers suivants. (Le lecteur de CD est le lecteur D dans cet 
exemple.)
D:\Drivers\WINXPX64 (version à 64 bits)
D:\Drivers\WINXPX86 (version à 32 bits)
Si vous n’utilisez pas le CD-ROM, allez sur le site web de Roland DG (http://www.rolanddg.com/) et téléchargez 
le pilote de la machine à supprimer. Sélectionnez ensuite le dossier où vous avez placé le fichier téléchargé.
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Fixer les cales

Quand vous déplacez la machine, veillez à fixer les cales. Si vous déplacez la machine sans fixer les cales, vous 
risquez de l’endommager.

Procédure

 Mettez la machine sous tension.
 "Etape 1: Mise sous tension" à la p. 27

 Retirez l’étau (ou la table).


Maintenez la tête.

Tête

Capuchon de tête

Attachez le capuchon de la tête.

 Mettez la machine hors tension.
 "Etape 3: Terminer l’impression (éteindre la machine)" à la p. 45



Interrupteur/bouton d’avance

Maintenez l’interrupteur/bouton d’avance en-
foncé pendant au moins dix secondes.
La tête se déplace à l’endroit illustré.
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

Soulever la tête.

Le centre de la 
molette doit se 

trouver juste 
au-dessus du triangle.

Serrer

Desserrer

Tête

Fixez la tête à la position la plus haute.
Après avoir desserré la molette, soulevez la tête à la 
position la plus élevée puis serrez la molette.

 Débranchez le cordon d’alimentation et le câble USB.

 Fixez les cales.
La machine est calée en trois points (avec 5 vis).  Fixez toutes les cales et serrez les vis avec la clé hexagonale 
fournie.

Cale
Cale

Arrière

Emplacement de stockage des 
cales et des vis

Clé 
hexagonale

 Fermez le couvercle et emballez la machine dans son emballage d’origine.
Quand vous transportez la machine, prenez-la toujours par le dessous avec les deux mains. Si vous portez 
la machine en la saisissant à un autre endroit, vous risquez de l’endommager.
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Surface imprimable

Etau

Pince

Surface 
imprimable

Surface non 
imprimable

Surface 
imprimable

Surface non 
imprimable

* Aucune impression ne peut se faire à moins de 10mm de la pince car la tête heurterait la pince.

Table

Surface imprimable maximum
80mm × 80mm

Ce réglage doit être effectué avec le pilote METAZA. 
Si une image excède la surface imprimable, l’impression 
risque d’être irrégulière en dehors de la surface imprimable.

Ligne centrale

Ligne 
centrale

Surface imprimable
50mm × 50mm 

Vue du haut de la table
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Emplacement de l’étiquette d’alimentation et du numéro de série

Numéro de série
Ce numéro vous sera demandé pour tout entretien 
ou assistance technique. Ne décollez jamais cette 
étiquette.

Caractéristiques d’alimentation
Utilisez exclusivement une prise secteur répondant 
aux spécifications de tension, de fréquence et 
d’ampérage imprimées ici.

Caractéristiques d’alimentation
Utilisez exclusivement une prise secteur 
répondant aux spécifications de tension, de 
fréquence et d’ampérage imprimées ici.

Arrière

Adaptateur secteur
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Caractéristiques techniques

MPX-90M

Supports compatibles Or, argent, cuivre, platine, laiton, aluminium, fer, acier inoxydable etc. 
(Dureté Vickers [HV] de la surface de gravure: 200 maximum)

Dimensions du support Maximum 100mm (largeur) x 200mm (profondeur) x 40mm (épaisseur) 
ou 200mm (largeur) x 100mm (profondeur) x 40mm (épaisseur) 
(L’épaisseur maximum avec l’étau est de 20mm.).

Surface d’impression 80mm x 80mm 

Résolution 529 dpi (High Resolution), 353 dpi (Photo), 265 dpi (Text), 1058 dpi 
(Vector)

Direction Gravure unidirectionnelle ou bidirectionnelle (sélectionnable avec le 
pilote Windows)

Vitesse de gravure (dé-
faut)

50mm/sec (Photo), 33mm/sec (High resolution/Text), 24mm/sec 
(Vector)

Interface USB (conforme à la norme “Universal Serial Bus” ver. 1.1) 

Alimentation Adaptateur secteur 
fourni

AC 100V~240V ±10% 50/60Hz 

Machine DC 19V 1.6A 

Consommation Environ 24W

Niveau de bruit Moins de 70dB(A)

Température ambiante 
(fonctionnement)

10~30°C

Humidité ambiante (fonc-
tionnement)

35~80% (sans condensation)

Dimensions externes 286mm (L) x 383mm (P) x 308mm (H)

Poids 11kg

Accessoires Adaptateur secteur, Câble d’alimentation, Supports de test, Etau, Câble 
USB,  CD-ROM contenant les logiciels Roland, Mode d’emploi etc.

Système requis pour la connexion USB

Ordinateur Modèle avec Windows XP, Windows Vista ou Windows 7 (édition 32 ou 64 bits), ou 
un ordinateur mis à jour à partir de la version Windows XP ou plus récente.

Câble USB Utilisez le câble USB fourni.
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